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IMPORTANT. READ ATTENTIVELY 
 

Castor-NOISE 5.0 FOR WINDOWS 95 
 
 
This License agreement for the End user of an application carried out by Castor 
Environmental Software (Castor Software) constitutes a legal agreement among you 
(either a person or an entity) and Castor Software regarding the software of Castor 
Software that includes the software and other related means, the printed materials 
(as the user's manual) and any other documentation (software). If you install, or 
you copy or you use this software or the user's manual, you accept the terms of the 
present License agreement for the End user. If you don't agree with the terms of 
this License agreement for the End user, don't install or use this product software 
and their related means; and return it where you acquired it.  
 
 
 

LICENSE OF SOFTWARE 
 
The software is protected by author's laws, by international treaties on copyright 
and by other laws and treaties on the intellectual property. The software carried 
out by Castor Software is allowed to use with license, it is not sold.  
 
Concession of License, The License agreement for the End User grants the following 
rights: 
 

 Software of Applications.- You will be allowed to install and to use a copy 
of the software in a PC. The main user of the PC will be able to make a 
second copy for his exclusive use in a portable PC. 

 
 Storage and use in the net.- You will also be allowed to install or to store 

a copy of the software in a storage device just as a network server.  
 

 However, you will acquire a license for each PC in which you can execute the 
software. You won't be allowed to share neither to use simultaneously in 
different PCs a license for the software. 

 
 Software not for sale.- It is not allowed to resell, or to transfer, for any 

money the software. 
 
 
Other rights and limitations. 
 

 It is not allowed to use technical of inverse engineering. 
 

 The software is granted with license as a unique product. Their components 
cannot separate to be used in more than a PC. 

 
 It is not allowed to rent or to lend the software. 

 
 All the rights shown in the License agreement for the End user can only be 

transferred with the condition that the receiver accepts the terms of this 
License agreement for the End user. 
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 Without prejudice of any other right, Castor Software can finish this License 
agreement for the End user if you don't fulfill the terms and conditions of 
the contract. In this case, you will destroy all the copies of the product 
software and their components. 

 
Copyright:  The ownership and copyright with regard to the software, the printed 
materials that accompany it and any copy of the product software is property of 
Castor Software. The software is protected by copyright laws and by international 
treaties. Consequently, you will try to the software like any other material 
subject to copyright with the difference that you will be allowed to install the 
software in a single PC. It is not allowed to copy the printed materials that 
accompany to the software. 
 

****** 
 

The parties to this agreement are Castor Environmental Software, hereinafter 
referred to as "Castor Software" the CASTOR-NOISE 5.0 Software user hereinafter 
referred to as "Licensee." 
 
EFFECTIVE DATE: This agreement shall take effect upon execution. 
 
LICENSED MATERIALS: Castor Software hereby grants to Licensee one (1) non-
exclusive, non-transferable, and royalty-free license to install the Licensed 
CASTOR-NOISE 5.0 system (application and user’s manual) on one computer, which is 
incorporated herein by reference. One computer is defined as one unique combination 
of Operating System(OS)/ Processor(CPU) / Hard Drive(HD). 
 
LICENSE PROVISIONS: Castor Software shall have no obligation to provide support, 
including but not limited to installation, maintenance, debugging and improvements, 
for Licensed Materials, except as Castor Software at its sole discretion, shall 
determine to be reasonable. Licensee agrees to make available to Castor Software 
any modifications or enhancements to the Licensed Materials provided under this 
agreement. Castor Software shall have the right to use such modifications and 
enhancements for any purpose whatsoever. 
 
NOTICES: Any notices required to be given or which shall be given under this 
agreement shall be in writing delivered by first-class mail. Notices shall be 
addressed to the parties as follows: 
 

License Manager 
Castor Software,  

 
WARRANTIES: Licensee agrees to accept the Licensed Materials on an "as is, with all 
defects" basis. Castor Software makes no warranties, express, implied in law or in 
fact, including any implied warranty of merchantability or fitness for a particular 
purpose, or results obtained from Licensee's use of Licensed Materials, or that the 
use of any Licensed Materials will not infringe on any patent, copyright or 
trademark or other rights. 
 
LIABILITY AND INDEMNIFICATION:  Castor Software shall not be liable for any manner 
of loss or damage arising out of the use of the materials provided hereunder. 
Further, Castor Software shall not be obligated to indemnify the Licensee in any 
manner for any loss which Licensee may experience, of any kind or nature, arising 
out of the use of the materials. 
 
ASSIGNMENT: This agreement shall inure to the benefit of and be binding upon the 
parties, and their respective successors and assigns. This agreement shall not be 
assigned by either party without the written consent of the other party thereto. 
 
GOVERNING LAW: This agreement shall be interpreted, enforced and construed 
according to the laws of the Kingdom of Spain. 
 
ENTIRE AGREEMENT: This agreement contains the entire agreement between the parties 
with respect to the subject matter hereof, and it shall not be modified or amended 
except by an instrument in writing signed by both parties hereto. 
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DISCLAIMER 
 
 The present document has been carried out by Castor Software in its entirety. 
Any mention that we can find in the manual of companies, official organisms, names, 
products or trademarks don't imply the participation of these in the realization of 
the present document neither in the development of the software. On the other hand, 
the mention that we can find in the manual of companies, official organisms, trade 
names, products or trademarks don't mean that they are recommended by Castor 
Software. The information contained in this document has been obtained by Castor 
Environmental Software of credible sources. Nevertheless, Castor Environmental 
Software doesn't guarantee the accuracy or perfection of the published information. 
Castor Environmental Software won't become responsible for any error, omission or 
damage caused by the use of the information of the manual present and of the 
software. With the use of the software and manual, Castor Environmental Software is 
not providing any specific professional service to carry out technical studies. 
Specialized professionals, hired for this, will carry out the pertinent studies. 
 
 The CASTOR-NOISE 5.0  software estimates the dispersion of noise in the air. 
These types of numeric simulations are a method to estimate the contamination in an 
approximate way. Castor Environmental Software doesn't guarantee that the results 
obtained by this program coincide with the real concentrations that we can find in 
the air. The software, the used algorithms and the manual have been conscientiously 
examined of the possible existence of errors or omissions. Although we have checked 
the operation of CASTOR-NOISE 5.0  keeping in mind the results that we can find in 
the existent scientific literature on the area, Castor Environmental Software is 
not responsible for errors or omissions that we can find in the software, in the 
used calculation algorithms and in this manual. Castor Environmental Software is 
not responsible for losses or damages caused by the use of this software or of the 
user's manual. This software has been conscientiously examined of the possible 
existence of computer virus before its distribution.  
 

Although we have used programs up-to-date antivirus of last generation and we 
have taken the maximum cautions in the development of the program and of the 
installation system, Castor Environmental Software is not responsible for losses or 
damages caused by these. We recommend that it maintains backup copies of all their 
fundamental data before installing the CASTOR-NOISE 5.0  software. 
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FOREWORD 
 
The numeric algorithms that CASTOR-NOISE 5.0  uses gives us the possibility to study the noise 
pollution that we find in our environment. The numerical method uses a equation that estimates the 
dispersion of the noise in the air.  
 
The software admits meteorological data to establish the form of the noise pollution. The software 
calculates the sound emission that is produced by each one of the sources and it considers the estates 
of the sources and the state of the atmosphere. CASTOR-NOISE 5.0 carries out temporary averages 
(daily, monthly or annual) so that you can calculate the pollution average in each point of the affected 
area.  
 
The system of simulation of processes of dispersion that CASTOR-NOISE 5.0  has, offers to the 
beginner and the expert programmer, a quick and practical system to evaluate the noise pollution. The 
program is based on the operating system Microsoft WINDOWS where one works intensively with the 
mouse and the graphic windows. The bars of icons facilitate the realization of the different tasks of the 
program. We can say, with a certain security that the software CASTOR-NOISE 5.0  is one of the best 
tools, to carry out numeric simulations of noise pollution processes. Without considering the 
experience that the user possesses in programming languages or in the use of simulation tools, in few 
minutes he will be able to have the first results.  
 
This manual will describe the use and the possibilities of CASTOR-NOISE 5.0 that we will show with 
the use of examples. It is not strictly necessary possessing knowledge on the handling of the operating 
system of Microsoft WINDOWS although it is advisable. Along the user's manual we will simulate 
some noise  pollution processes whose development will illustrate the use of the program in the case 
of complex systems. We will describe the necessary steps for the study of a noise pollution process 
with the software.  
 
Finally, we will say that they exist in the scientific literature a great quantity of models to evaluate the 
dispersion of noise in the air. In this way, we will obtain numeric differences among the results of the 
program and the results of other numeric models. This is not strange since there are numeric 
differences among the different models of the scientific literature. The problem is that the dispersion is 
a complex physical phenomenon (that involves turbulences, non-linear dynamics and thermodynamic 
of the irreversible processes) and we want to simplify it with a simple equation. 
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1. Introduction 

  
 

Our planet is fragile and limited as for its potential of 
generating the resources that the humanity requests and its 
capacity to absorb the residuals that we emit. The 
precariousness of the ecological and environmental resistance 
of the earth can end up threatening the humanity's 
development. IUICN, PNUMA, WWF and Agenda 21 plead insistently 
to reach the sustainable development. This admits a growth and 
an evolution of the carrying capacity of the ecosystems, 
without committing the necessities of the future generations, 
by means of the environmental administration of the different 
places of the Planet. 

 
 

2. Administration and Environmental Impact 
 
 

The environmental administration is based on two 
fundamental tools:  the planning and the evaluation of the 
environmental impact. These two instruments are fundamental to 
coordinate the human activity and to maintain the quality of 
the environmental resources. The process of environmental 
planning combines the characteristics of each place with the 
possibilities of economic development. We will define 
administration objectives that will achieve the optimization 
of the use of the resources minimizing the impact generated on 
the environment. We will define the environmental impact that 
suffers a certain region as the difference among the future 
environmental situation of the place, after the realization of 
a project, and the environmental state of the area if this 
project had never taken place.  The correct diagnosis of the 
impact demands to know all the elements implied in the 
environmental process. A study of environmental impact will 
also include a planning of the environmental surveillance of 
the project.  

 
 One of the fundamental physical systems for the study 
of the environmental quality of a region is the atmosphere. 
The atmosphere play a fundamental paper in the development of 
the life. In this software, we will center ourselves in the 
study and in the administration of the noise pollution.  
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3. Noise pollution 
  

The word "noise" comes the Latin word "nausea" meaning  
Sea sickness. Noise is among the most pervasive pollutants 
today. Noise pollution can be caused by many sources including 
highways, vehicles, factories, engines, machine, aircraft, 
helicopters, industrial development and construction work. 
Noise negatively affects human health and well-being. Problems 
related to noise include stress, sleep loss, distraction, and 
a general reduction in the quality of life. Noise pollution 
can be also harmful to animals. High enough levels of noise 
pollution may interfere with the natural cycles of animals. 
 

Noises are irregular and disordered vibrations including all 
possible frequencies. The intensity of a sound I can be 
expressed in decibels with the standard equation: 

L=10 log(I/I0) 

 
where I0 is the quietest sound most people can hear, the 
threshold of hearing 10-12Wm-2.  When the ratio is between two 
field strength (so that the power being transmitted is 
proportional to the square of the pressure, the formula is: 
 

LdB=10 log[p2/(p0)2] 

 

The decibel unit is often used in acoustics to quantify sound 
levels relative to some 0 dB reference. The reference may be 
defined as a sound pressure level (SPL), commonly 20 
micropascals. The reference sound pressure (corresponding to a 
sound pressure level of 0 dB) can also be defined as the sound 
pressure at the threshold of human hearing, which is 
conventionally taken to be 20 micropascals. It can therefore 
be seen that a ratio expressed in decibels. A-weighted 
decibels are abbreviated dB(A) . When acoustic measurements 
are being referred to, then the units used will be dB SPL 
(sound pressure level) referenced to 20 micropascals = 0 dB 
SPL.  

 

The frequency range of sound audible to humans is 
approximately between 20 and 20,000 Hz. The amplitude range of 
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sound for humans has a lower limit of 0dB, called the 
threshold of hearing. Sound is technically at its upper limit 
at 194.09 dB. Sounds begin to do damage to ears at 85 dB and 
sounds above approximately 130 dB. 

 
 

dB Source 

250 Inside of tornado 

180 Rocket engine at 30 m 

120 Jet aircraft taking off at 100 m 

100 Pneumatic hammer at 2 m 

90 heavy truck at 1 m 

70 Busy traffic at 5 m 

60 Office inside 

40 Residential area 

10 Human breathing 

0 
Threshold of hearing (human 
with good ears) 
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The intensity of two sounds L1 and L2 can be added in decibels 
with the standard equation: 
 
LdB=10 log[(p1/p0)2+[(p2/p0)2] 

 
and then, 
 
LdB=10 log[10L1/10+ 10L2/10] 

 
In this way, decibels from two different sources can be added.  
CASTOR-NOISE 5.0 Software will consider this method of 
calculation.  
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3. Before you begin 
 

Welcome to CASTOR-NOISE 5.0 - software for noise 
pollution modeling. The CASTOR-NOISE 5.0 Software allows you 
to create robust and useful numeric simulations that fully 
make use of the graphical user interface. This chapter show 
you how to sep up CASTOR-NOISE 5.0 on your computer. 
 

We can say, with a certain security that the software 
CASTOR-NOISE 5.0  are one of the best tools, if not the best 
and simpler, to carry out numeric simulations of noise 
pollution. It takes just a few minutes to build your first 
numerical simulation. 

 

Due to the features of the software that allows to simulate the 
process of noise pollution immediately, the numeric simulation is 
carried out with a remarkable speed.  

 

You create the graphical interface for your pollutant 
sources by drawing point sources in a graphical way. You 
create the simulation process by drawing point sources on the 
CASTOR-NOISE 5.0 window. Next, you set properties for the 
point sources and ambient data to specify such values as 
temperature, noise power,… Finally, the numeric simulation is 
carrier out. 

 

3.1 CASTOR-NOISE 5.0 Software 
 

Before you attempt to install and use the program, make 
sure your personal computer meets the hardware and software 
requirements shown in the following table. 

 

 System requirements: Windows 95, 98, 2000 and XP 

 CD-ROM drive 

 RAM Memory: 16MB or higher 
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3.2 Installation  
 

 Insert the CD. The CASTOR-NOISE 5.0 CD window appears on 
your screen. 

 Click the button labeled SETUP and follow the 
instructions on the screen. 

 

If the CASTOR-NOISE 5.0 CD window does not appear, the CD 
autorun feature might be disabled on your computer. To install 
CASTOR-NOISE 5.0, open the CD-ROM drive icon, open the PC 
directory, and double-click the Installer icon. 

 

3.3 Starting CASTOR-NOISE 5.0 
 

Click Start, go to Programs, and choose CASTOR-NOISE 5.0 
. Here is the program window after startup. 
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The window has a Menu bar at the top, a Status bar at the 
bottom and a basic tool bar in the window. The program 
commands are available through the menus and toolbar buttons. 
Some commands have associated dialog boxes which you can 
choose additional options. 
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4. Understanding the Workplace 
 

The MS Windows bar doesn’t appear. In this way, you have 
more space to draw. However, and if you want, you can modify 
the properties of the MS Windows bar in the Microsoft Windows 
system. The program window size is fixed and it cannot modify. 
The menu bar lists the menus shown above. When you choose one 
of the menus, the program displays a pull-down list of 
available commands. The menu bar lists: File, View, Sources, 
Ambient data, Tools, Options and About CASTOR-NOISE 5.0. The 
program window has a basic tool bar at the top. 

 

In the center of the program window, we will draw and we 
will calculate the different polluting processes. We draw 
using a plane that is parallel to the land surface (XY). There 
is a grid in the XY-plane. The coordinate origin is on the 
left bottom corner (X=0, Y=0).  

 

The program window is a XY-plane (parallel to the land surface). A 
noise source is represented by a small square. 

 

In the Status bar at the bottom, we have X and Y coordinate 
values in meters and data on our environmental system. Point 
the mouse where you want in the program window and the X and Y 
values will be shown in the status bar at the bottom.  

 

On the left bottom corner, two different text boxes appear: The 
position of the XY-coordinates and the noise value in decibels, dB(A). 
Point the mouse where you want in the program window and the 
noise value will be shown in the text box.  

 

The noise levels will be calculated in a parallel plane to the 
land surface (XY-Plane). The plane height will be determined 
by the user (zr).  

 
 

All the points of the XY-plane will be to a zr height. The zr 
value is chosen by the user before the calculation. We will be 
able to make many calculations considering different plane 
heights. The different plane heights will be determined by the 
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user (zr values). In this way, the physical form of the noise 
power can be studied.  
 
Example: Calculation in the XY-plane, zr=0 (height of the land 
surface). The red square represents a point source. The red 
colour represents high noise levels. 
 
 

 
 
 

4.1 Menu Bar 
 

Display the commands you use to build your simulation. 
When you choose one of the menus, the program displays a pull-
down list of available commands. The program window has a 
basic tool bar under the Menu bar. The tool bar provides quick 
access to commonly used commands in the program. You click a 
button on the toolbar once to carry out the action represented 
by that button.  

 

For example, when you choose File in the Menu bar, the 
program displays: 
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4.1.1 File 

 
The File Menu contains the tools you use to open, close 

and save new and existing files, and import and export 
graphics. The File Menu lists: New, Open, Save, Import 
Picture, Export Picture, Print, Print Picture and Exit. 

 

New.- This command is to begin a new simulation, deleting all 
that has been made previously.  

 

Save the work with the Save command before clicking the New 
command.  The program doesn't allow to open two files at the same 
time. This way, we can optimize the available memory and the 
calculation speed. 
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Open.- This command is to open an existing file. The program 
files exist as separate files with .cus filename extension. 

 

Save the current work with the Save command before clicking the 
Open command.  The program doesn't allow to open two files at the 
same time. 

 

Save.- This command is to save an existing result.  

 

The process of saving a file is carried out proportionally to the size 
in which the elements are drawn in the screen. Then, the saved file 
will depend on the screen format that we are using (for example, 
1280x1024,…). If we try to read a file, saved in another different 
computer, we will have problems to open it. 

 

Import Picture.- With this command you will be able to import 
images and pictures (previously saved BMP files). These images 
will be background pictures and images for your program 
window. You can display an image by double-clicking the 
filename of a bitmap (BMP). 

 

Many programs and computer applications (AutoCad, 3d Studio, 
ArcView,...) export BMP files. You will be able to load pictures and 
images generated by these programs. 

 

The displayed image size will depend on the size that had when 
it was saved. If it is necessary, modify the picture size 
before loading the image (for example, you can use windows 
Paint, Adobe Photoshop,… ). You will be able to load BMP maps 
generated by AutoCad. 

 

Bitmaps and scanned maps must be loaded into memory and then 
adapted to the program scale (we will make use of the Scale 
command). The X-Axis width (meters) in the program window can 
be easily changed to be able to compare both images 
(simulation results and background maps). Then, the X-Axis 
width (in meters) of the imported map and the X-Axis width (in 
meters) of the program window match together. The imported 
images are not stored physically in the simulation process. 
Terrain elevations (represented on the imported map) don’t 
interact in the simulation process (sound reflections). We 
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haven't the possibility to zoom an imported map with the Zoom 
command. This command only acts in the calculation process. If 
it is necessary, zoom  the map before loading the image. 

 

Export Picture.- With this command you will be able to export 
images and pictures (BMP files). These images will contain the 
background picture and the simulation results. 

 

Many programs, computer applications and word processors 
(AutoCad, 3d Studio, ArcView, MS Word,...) import BMP files. You 
will be able to load images generated by CASTOR-NOISE 5.0. 

 

Print.- The users’ printer drivers and printers impact print 
quality. With this command you can send graphics and text (of 
the simulation results) to a printer. This command provides 
the best printing quality across a variety of printers because 
Windows translate text and graphics from the device-
independent drawing space to the Printer object to best match 
the resolution and abilities of the printer. However, the 
background pictures cannot be printed. 

 

Print image.- This command send a pixel-by-pixel image of the 
program window to the printer. To print with Print image 
command, you must first display that information on the 
program window and then print with this command. This command 
is by far the easiest way to print from your application.  
Because it may send information to the printer at the 
resolution of the user’s screen (typically 96 dots per inch), 
results can be disappointing on printers with much higher 
resolutions (typically 300 dots per inch for laser printers).  

 

Exit.- The Exit command allows you to exit directly from the 
application. 

 

4.1.2 View 
 

The View Menu contains the tools you use to view your 
computer screen. The File Menu lists: Zoom, Black background, 
White background, Draw grid lines, Eliminate grid lines, Draw 
picture, Eliminate picture and XY and XZ view. 
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Zoom.- We have the possibility to zoom a part of the program 
window with the Zoom command. However, we won't be able to 
enlarge background pictures with this command. If it is 
necessary, zoom the map before loading the background image. 
This command only acts in the calculation process. This way, 
we can place a point source in a side of the computer screen 
and we can calculate the concentrations in another different 
detailed region. 
 
 

 
 
 
To activate the Zoom command, eliminate the background picture 
first. 
 
Black background.- The Black background command allows you to 
have a black background colour in your screen. 
 
White background.- The White background command allows you to 
have a white background colour in your screen. 
 
Draw grid lines.- If you select Draw grid lines command, the 
grid appears. 
 
Eliminate grid lines.- If you select Eliminate grid lines 
command, the grid disappears. 
 
Draw picture.-  With this command you will be able to see  
background images and pictures (previously loaded BMP files).  

 
Eliminate picture.- With this command you will eliminate  
background images and pictures (previously loaded BMP files).  
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XY and XZ view.- These command are to get views of the XY and 
XZ planes. 
 
 

4.1.3 Source 
 

The Sources Menu lists the possible noise sources: the 
point source and the line source. 

 
 

 
 
 

 

Point source.- This is a point source. The source size is 
small if we compare it with the size of the area in which we 
are simulating (point source). If you click this button, the 
next dialog box is shown: 
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The necessary data is: 

 

External source/internal source/airport options: This is 
the External/internal/airport option. External means a 
noise source placed out of a building (for example, a 
vehicle engine). 

 

External surface (m2): In the internal source option, this 
is the external area of the building.  

 

Noise insulation (dB): In the internal source option, this 
is the noise insulation value. 

 

Noise power (dB): This is the noise power at source 
position in decibels. 
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Airport options: We have two options: An aircraft 
landing/taking off at 300m or Daily average (number of 
airport operations in a day). 

 

 

Noise power estimation: With this button, you can estimate the 
noise level if it is unknown. If you know the power, you don't 
need to use this command. You can write it directly in the 
noise power textbox. If you click this button, the next dialog 
box is shown: 
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If you click the OK button, the next program window is shown 

 

 

 

 

Two blue axis points the place where we can fix the source 
position. After clicking the program window, you draw the 
point source. 
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The small fuchsia square shows the source location. We can 
draw all the noise sources that we want (up to 1,000). To 
change the point source data, we can click the source location 
in the program window. Then, the point source dialogbox is 
again displayed. We are not able to put two noise sources in 
the same location. The older one is eliminated automatically. 

   

Line source.- This is a line source of noise. The line width 
is small if we compare it with the size of the area in which 
we are simulating (line source). If you click this button, the 
next dialog box is shown: 
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Here, only some data can be modified. The necessary data is: 

 

Noise level (dB): This is the noise power at source position 
in decibels. 

 

Noise power estimation: With this button, you can estimate the 
noise level if it is unknown. If you know the power, you don't 
need to use this command. You can write it directly in the 
noise power textbox. If you click this button, the next dialog 
box is shown: 
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If you click the OK button in the Line source data window, the 
next program window is shown 
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If you click the computer screen and move the mouse, a 
straight line is shown 

 
 

 

If you click again on the computer screen, a line source is 
drawn 
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4.1.4 Ambient data 
 
Ambient conditions are defined by the land and atmospheric 
conditions in the vicinity of the pollutant emission. The 
Ambient data Menu lists: terrain, topographic lines and 
barriers. 
 

 

 

 
 

 

  

 

Terrain.- This command is to draw topographical lines. If you 
click this command, the next dialog box is shown: 
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This window is to determine the reduction of sound with 
distance. It is often used to describe the change in sound 
level as one move toward or away from a sound source. 
Attenuation coefficient can describe the reduction of sound 
per unit distance. It depends on temperature and relative 
humidity. If you don’t want to work with frequencies, you can 
use an average frequency for the simulation, 2000 Hz. 
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Topographic lines.- This command is to draw topographical 
lines. If you click this command, the next dialog box is 
shown: 

 

 

 

The height of the contour line can be written in the textbox. 
If you click the Accept button, the next computer screen is 
shown: 
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Then, and if you click the computer screen and move the mouse 
(mouse down), a square is shown and when you mouse up (the 
height of the contour line is different to zero): 

 



                                                                                                                                                             
CastorNOISE  

27 

 

 

 

 

 

The area inside this contour has a 10m height. A rectangle 
elevation could be represented by the program in the next way: 
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To draw a small mountain, we can use a lot of small 
rectangles. 

 

 

10m 

Y 

X 

X 

Z 

10m 
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A mountain could be represented by the program in the next 
way: 

 

 

 

 

Barriers.- With this command, you can draw barriers on the 
computer screen. The barrier can be eliminated through the 
ELIMINATE command (used also to eliminate sources). 

The software calculates the shadow regions and it applies 
attenuations values in that places. The buildings can be also 
considered as sound barriers. 

 

 
(1) Source  
(2) top - receptor (without transmission loss) e down - 
receptor (with transmission loss) 
(3) Barrier 

X 

Z 
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(4) Shadow region  
(5) Direct 
(6) Difraction 

  

Transmission loss: 

 Material 
 

Thickness 
mm  

Surface 
Density 
kg/m2  

 
Transmission 
Loss, dB (A) 

(Polycarbonate) 8-12 10-14 30-33 

(Acrylic -Poly-Methyl-Meta- 
Acrylate (PMMA)-) 15 18 32 

(Concrete Block 200x200x400 
light weight)  200 151 34 

(Dense concrete) 100 244 40 

(Light concrete) 150 244 39 

(Light concrete) 100 161 36 

(Brick) 150 288 40 

(Steel), 18 ga 1.27 9.8 25 

(Steel), 20 ga 0.95 7.3 22 

(Steel), 22 ga 0.79 6.1 20 

(Steel), 24 ga 0.64 4.9 18 

(Aluminium Sheet) 1.59 4.4 23 

(Aluminium Sheet) 3.18 8.8 25 

(Aluminium Sheet) 6.35 17.1 27 

(Wood) 25 18 21 
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(Plywood) 13 8.3 20 

(Plywood) 25 16.1 23 

(Absorptive panels with 
polyester film backed by 
metal sheet) 

50-125 20-30 30-47 

(* Values assuming no openings or gaps in the barriers) 

 
The calculation result is better if you introduce more than 
one barrier. Example: 

 
One barrier: 
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Several barriers: 

 

 

For more than 4 barriers, the calculation converges. We use 
the same model as London and Hong Kong. 

 
An important point is that the topographic line command doen’t 
consider sound reflections. You need to pay attention if you 
use both commands (topographic lines and barriers) at the same 
time.  
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4.1.5 Tools 
 

The Tools Menu contains the tools you use to process your 
data. The File Menu lists: Temporal average, Delete, Axis 
scale, XY and XZ Calculation, Colour gradient, Isolines, 
Numerical grid and Calculation parameters. When you choose 
Tools in the Menu bar, the program displays: 

 
 

 
 

Temporal average.- Some discharge data can vary with time (air 
temperature, noise power,...). Taking this into account, the 
program can do temporal averages in the calculation. In the 
CASTOR-NOISE 5.0 Software, these data are allowed to vary with 
time. If you click this command, the next dialog box is shown: 
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We can write in the text box the number of temporal points per 
average. To be able to make an average, we will take more than 
a temporal point. 

 

The temporary points are elements of an average and we will be 
able to relate them with any temporary instant. That is to say, if we 
have data of air temperature for every hour of one day (a total of 
24) and we want to make an average of the noise pollution in one 
day, we will be able to make a temporal average with 24 temporal 
points to calculate the daily average. 

 

Each temporary point that we average represents the data in a 
hour of time. If we have monthly data, and we want to make an 
annual average, we will be able to average with 12 temporary 
points (the twelve months). Then, and if you click the OK 
button, the next dialog box is shown: 
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The window allows to visualize the data to make the average. 
It also allows to modify the data or to change them. We have 
two groups of data that can vary in time: Terrain and Source 
data.  

 

At the top of the dialog box, two different text boxes appear: source 
label and temporal point label.  We can click both arrows to change 
these values and to visualize the data. 

 

Every time that you enable a new average, the software 
allocates to all temporal points the same quantities. These 
quantities coincide with the values that we had in the Terrain 
and Source dialogboxes before enabling an average. To modify 
the ambient and emission data in the temporal average, we can 
click Terrain and Source buttons in the dialogbox. Then, and 
if you click the Terrain button, the next dialog box is shown: 
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Some data of the dialog box cannot be modified: the 
attenuation options can not be modified. There is not interest 
in varying these data in time. To modify these data, we will 
have before to disable the temporal average and to open the 
source and Terrain dialogboxes in the source Menu and in the 
Ambient data Menu, respectively. To disable the temporary 
average, we will have to click the Temporal average command 
and to write 1 in the textbox of the Number of temporal 
points. 

 

If you click the source button in the Temporal average 
dialogbox, the next dialog box is shown: 
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Some data of the dialog box cannot be modified: the external 
surface,... There is not interest in varying this data in time 
To modify these data, we will have before to disable the 
temporal average and to open the source and terrain 
dialogboxes in the Source Menu and in the Ambient data Menu, 
respectively. To disable the temporary average, we will have 
to click the Temporal average command and to write 1 in the 
textbox of the Number of temporal points. 

 

Before running the calculation it is convenient to check the 
data that we have in the average. 

 

If we enable an average with more than a temporal point, and 
if later we increase the number of temporal points, it is 
necessary to be careful since there are data that can have 
null value. The ideal procedure is to define well, and from 
the beginning, the number of temporal points before writing 
the values for the average. If we want to modify an activated 
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average it can be more comfortable to delete the activated 
average and then to define a new one. To delete a temporal 
average, we will have to click the Temporal average command 
and to write 1 in the textbox of the Number of temporal 
points. 

 

Delete.- This command is used to delete pollutant sources that 
we don't want in the simulation. If you click the Delete 
button, the next program window is shown: 

 

  

 

 

 

Clicking on these points we will delete them from the screen 
and from the calculation. 

 

Scale.- With this command, we will decide the work area size 
in the simulation process. It is an important tool because 
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with their good use we will be able to interpret and to 
extract interesting data of the numeric simulation. The scale 
is defined according to the width in meters that we want to 
associate to the X-Axis of our program window. If you click 
the Scale button, the next program window is shown: 

 

 

 

 

In this window we will be able to choose the number of meters 
that we want to have in the X-Axis. When we have the value 
written in the textbox, we will make click with the mouse on  
Accept button and this value will be modified and the previous 
window will disappear. If we click the Cancel button it closes 
the window without modifying the value. This command will be 
used before using the calculation command, since this 
parameter should be perfectly defined before making the 
simulation. When we use this program command, we clean the 
whole screen of the computer and we lose all the elements of 
the simulation placed previously. If we don't want to lose the 
information obtained until the moment we will use the Save 
command before executing the Scale command. 

 

In certain situations, it can be interesting to have a high 
number of meters in the X-Axis for a better visualization. To 
illustrate the use of this command, we will carry out the same 
simulation varying the scale. We will use three different 
scales. Here, the width of the X-Axis is 5,000 m. 
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Here, the width of the X-Axis is 15,000 m. 
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Here, the width of the X-Axis is 100 m. 

 

 

 

 

 

 

As we can see, when the X-Axis is 5,000 m, it is when we have 
a clearer representation, where it is shown the value of the 
maximum point and the concentration lines clearly.  

 

Calculation (XY and XZ plane).- The calculation commands run 
the necessary algorithm to carry out the numeric simulation. 
We will run the command after having fixed the necessary data 
for the simulation, that is to say, the sources, the ambient 
data, the scale,... If we change any initial data (as the 
position of the source,...),  we will need to run the command 
again so that this is reflected in the result. If we make 
click on XY-Calculation command, we open the following window 
: 
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In this window we will be able to choose if we want to carry 
out the calculation in the land surface or to a certain height 
(two options). In the first option, the calculation of the 
noise pollution will be carried out at surface height. If we 
choose the option for the calculation to a certain height, we 
will write in the textbox the plane height in which we will 
obtain the results (0m for the surface of the sea). If we make 
click on XZ-Calculation command, we open the following window: 
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The program works in the following way: while it calculates, the 
machine centers all the capacity of the CPU in the calculation, 
stopping the other tasks of Windows. If we want to stop a tedious 
calculation, we will be able to make it making use of the keys 
CTRL+ALT+DEL.  

 

Colour gradient.- This command is to draw maps of noise 
pollution making use of a colour gradient. It is specially 
useful when the variation of the noise levels is very strong 
in a very short distance. The program takes the maximum value 
of the noise and it assigns to the maximum the red colour. 
Then, the program assigns the different colours to the grade 
of noise pollution in a qualitative way. We will be able to 
obtain the exact values locating the arrow of the mouse on any 
point and looking at the inferior right textbox of the 
program.  

 

Isolines.- This command induces an opposite effect. We will 
use this command with the purpose of obtaining the isolines 
again. This way we will be able to change representation 
easily making use of these last two commands. 

 

Numerical grid.- This command allows us another alternative 
representation of the calculated noise levels. It establishes 
a numerical grid throughout the calculation screen. It is 
specially useful if we load topographical planes, because with 
the other representations there are many images in the screen. 
If you click the Numerical grid button, the next program 
window is shown: 
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Calculation parameters.- This command will show us the 
parameters that we have assigned before carrying out the 
calculation. It is convenient their use with the purpose of 
verifying that we have written the parameters correctly. Once 
finish the calculation, the command shows us, also, the value 
of the maximum noise level and its position.  

 

4.1.6 Options 
 

The Options Menu includes all the elements for the 
numeric configuration of the simulations. We will use these 
commands before using the calculation command because these 
parameters should be perfectly defined before running the 
simulation. The Options Menu lists: Grid size, Number of 
Isolines, Calculation colours, Fonts and Calculation models. 

When you choose Options in the Menu bar, the program 
displays: 
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Grid size.- The grid size is an important parameter in the 
configuration of the system. We will decide the number of 
calculation points in the grid that we will take to make the 
simulation. As we increase the number of points, the computer 
will take much more time in carrying out the calculation but 
the result will be much more exact. If you click the Grid size 
command, the next program window is shown: 

 

 

In this window we will be able to choose the number of grid 
points (calculation points) that we want to have in the X-
Axis. The number of points to calculate will increase 
quadratically with the number of grid points along the X-Axis 
N, that is to say, it will increase as N2. 

 

To increase the number of grid points produces that the program 
needs much more RAM-memory. If we take such a high number of 
grid points that it overcomes the available memory of the PC, the 
computer will be blocked. 

 

Number of isolines.- This command is an auxiliary tool for 
making the maps of noise pollution. We will decide the number 
of isolines in the screen that we will take to make the 
representation. In certain situations, it can be interesting 
to have a high number of isolines for a better visualization. 
We will use this command before using the calculation command 
because this parameter should be perfectly defined before 
running the simulation. If you click the Number of isolines 
button, the next program window is shown: 
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In this window we will be able to choose the number of 
isolines that we want to have in our computer screen. To 
calculate the lines, the program also considers the maximum 
point as a line. 

 

To illustrate the use of this command, we will carry out the 
same simulation varying the number of isolines. We will use 
three different number of isolines. Here, the number of 
isolines is 7.  
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Here, the number of isolines is 3. 

 

 

 

Here, the number of isolines is 17. 
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Calculation colours.- By means of this command, we will be 
able to change the colors of the isolines, of the maximum 
point and of the point sources. 

 

Fonts.- This command is an auxiliary tool for making the maps 
of noise pollution. In this command we have two different 
options. We can choose: font size and source label (Yes/No). 
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Calculation models.- This option is to decide the mathematical 
model that will be used in the calculation. We can choose 
between two different models: Classical CASTOR-NOISE 5.0 model 
and ISO-9613. The ISO method of calculation can be used for 
punctual sources considering humidity, temperature and the 
solid angle for the source. In the case of roads, only angle 
solid effects will be considered when the ISO option is 
activated.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.1.7 GIS 
 

In this option it can be found all necessary to work with 
geographical information system.  

 

Coordinates of the origin.- With this command we can choose 
the value for the origin of coordinates. It is initially in 
the left bottom corner of the program window. It is possible 
to work with geographic and Cartesian coordinates (X = 
Longitude and Y = Latitude). 
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Reference points.- With this command we can decide the 
coordinate values of a point, that we previously know, in the 
map in order to have a referenced system. It is possible to 
work with geographical and Cartesian coordinates. Once you 
have introduced the desired coordinates, you make ‘click’ in 
the point of the screen where you want to situate the 
reference. In this point will appear red marker. After that, 
it will be possible to export the results to a GIS system.  

  

Radius of curvature.- By means of this command, you can choose 
a 
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value for the Earth radius. This radius can be slightly 
modified to adjust the reference system with the available 
data. The program considers the Earth as a perfect sphere with 
an exact radius. We know that this is not exactly true. This 
option is to correct this kind of effects.  

  

 

 

 

 

 

Scale 

calculation.- With this command it is possible to estimate the 
map scale that corresponds to a background image, that has 
trees previously imported by the user. It is necessary to know 
the distance between to different points in the map. After 
introducing the distance data, you can click consecutively 
both points, and the scale will be automatically calculated. 
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Export maximum, concentrations,….- These are to export the 
different elements of the programs (isolines, source 
positions,…) to Microsoft EXCEL csv file. To import without 
problems with Arcview we have used the english format system 
for the numbers. For example, one euro and 30 cents is 1.30 
euros (NOT 1,30!) in the english format.  
If you are using the spanish format, when you open the 
exported file with EXCEL you obtain “al numbers in the same 
box”. In such a case, the best way is to change your number 
format in your computer. It is very easy. Just go to WINDOWS 
>> START >> CONTROL PANEL >> REGIONAL CONFIGURATION and look 
for english format before opening with your EXCEL program. 
 

4.1.8 3D 
 
The 3D commands are for a qualitative representation, not 
quantitative. The system generates random points to help you 
to obtain a 3D view of the pollution process. The pollution 
concentration value that appears in the screen is an 
orientative value. In the 3D options you can modify the number 
of random points and other parameters. The TEMPORAL AVERAGE 
command doesn’t work in 3D and the barriers haven’t effect on 
the calculations. 

 

The 3D window is an extension of the 2D XY window. The X 
coordinate, Y coordinate and concentration value that appear 
on the bottom of the screen correspond to the XY plane view. 
The calculated XY data will be deleted after a 3D calculation. 
The PRINT command only prints the XY view. To print in 3D, you 
need to use the PRINT IMAGE command. Or you can save a BMP 
file and print such a file with an another standard program 
(windows PAINT, ...). 

 

4.2 Icon bar 
 

The menu bar display the commands you use to build your 
simulation. When you choose one of the menus, the program 
displays a pull-down list of available commands. The program 
window has a basic icon bar under the Menu bar. The icon bar 
provides quick access to commonly used commands in the 
program. You click a button on the icon bar once to carry out 
the action represented by that button.  
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5. Working with Google maps 
 

 

1. Firstly you can can navigate to Google maps web.  
http://maps.google.com/ 
 
 
 

 
  
 
 
 
2. Using the screen arrows move to the map area that you want 
to watch. For example, we can watch Garachico in Tenerife 
North. 
  



Castor   Environmental Impact Software 

 

 

54 

 
  
  
 
3. For the image capture, it is possible to use in the 
keyboard Ctrl+Alt+PrtSc). In the keyboard you can push at the 
same time (Ctrl+Alt+PrtSc). In that way, the screen image is 
copied by the computer memory. 
 
  
  
4. Open the windows PAINT program (Windows >> Start>> 
Programs>> Accessories >> PAINT).  
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5. To paste the image that has been previously copied in the 
computer memory, you can use the commands (Edit >> Paste in 
the PAINT program) or (Ctrl+V). You can watch now the copied 
image from the Google maps web page. 
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6. It is obvious that you don't want to watch the navigator 
bars that appears in the screen. Use the arrows of the PAINT 
program to center the image, that you are interested for, in 
your computer screen. In the toolbar of PAINT, you can use the 
icon SELECT (it is on top of the toolbar and at the right in 
the last picture). Drag the mouse arrow selecting the screen 
area that you are interested for. For our case, it is the 
rectangle where the picture of the terrain appears. 
  

 
  

 

  
7. Copy now the selected area by the rectangle in the last 
image using (Ctrl+C) or the command (PAINT Edit>>Copy) in the 
PAINT program. Then, you can use the command (File>>New) in 
the PAINT to have a new and clear screen 
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8. Use (Ctlr+V) command in the keyboard, or (Edit>>Copy) in 
the PAINT program to paste the selected retangle. The copy of 
the image appears now in the PAINT screen. The scale of the 
map imported from Google maps appears now in our screen 
(marked by a yellow arrow). This will be of great interest in 
a near future. It is important to have this scale in the image 
that you have selected. 
  



Castor   Environmental Impact Software 

 

 

58 

 

  

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9. Save the file using BMP format using the commands of the 
PAINT program (File>> Save as. . .). Then, you can open the 
previously saved BMP file using the program. 
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10. To work in the correct scale, we need to check the scale 
bar width in the Google map. The Google scale bar is between 
the red and yellow arrows (in the next picture). The Google 
bar width is in meters. When we put the mouse pointer in the 
point of the red arrow we can see the X-Coordinate value in 
the box marked by a blue arrow. If we put now the mouse 
pointer in the point of the yellow arrow, we will obtain a new 
value for the X-coordinate. The difference between both values 
in meters must be the same that the original Google bar width 
in meters to be in the correct scale. 
  

 
  
 
When we put the mouse pointer in the point of red arrow, it is 
found 7 m in the X-Coordinate box (marked with a blue arrow). 
If we do the same with the yellow arrow, we obtain 75 m in the 
box marked with a blue arrow. Then, and in our actual scale, 
the bar width have 75 m -7m = 68m. However, the correct value 
in the original Google scale is 100 m. The correcting ratio is  
  
P = 100/68 = (real value)/ (our value). 
  
P=100/68=1.47 
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11. To work in the correct scale, we have two methods: 
 
 
METHOD A: 
We go now to program>> GIS >> Scale calculation in the program 
and we get 
  

 

  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
We replace the 300m value that appears in the last picture by 
100m (the original Google bar width in meters) and 'click' 
ACCEPT. Then we click firstly in the left extreme of the 
original Google scale bar and secondly, we click again in the 
right extreme of the original Google scale bar (both points in 
the screen were market with red and yellow arrows in the last 
step 10). The imported Google map is now in the correct sale 
and we can check it. When we put the mouse pointer in the red 
arrow, we get an X-Coordinate value equal to 10 m (in the box 
market with a blue arrow). We can also get 110 m for the 
position market with the point of the yellow arrow. The 
difference is now 110 in -10m = 100 m. Such a value coincides 
with the original value of the Google map bar. So, the program 
scale is correct now. 
  
METHOD B: 
We go now to program>> Tools >> Scale in the program and we 
get 
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Now we multiply (our actual X-Axis width) by P to get the 
correct X-axis width, 
  
(correct X-Axis width)=Px(X-Axis width) 
  
(correct X-Axis width)=1.47x1000=1470m 
  
And we introduce the new X-Axis width and click ACCEPT in the 
last window. The imported Google map is now in the correct 
scale and we can check it. When we put the mouse pointer in 
the red arrow, we get an X-Coordinate value equal to 10 m (in 
the box market with a blue arrow). We can also get 110 m for 
the position market with the point of the yellow arrow. The 
difference is now 110 in -10m = 100 m. Such a value coincides 
with the original value of the Google map bar. So, the program 
scale is correct now. 
  
  
12. Now we introduce a pollutant source and we make the 
simulation. The result can be exported to a BMP file using the 
software. 
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13. We can repeat the 6-7-8 steps 'in order to eliminate not 
necessary parts in the picture. At the end we have a clean 
image with both the Google map and the simulation process 
results. 
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6. Application structure 
 

 

In this section, the general structure of the application 
will be shown. The Options Menu includes all the elements for 
the numeric configuration of the simulations. We will use 
these commands before using the calculation command because 
these parameters should be perfectly defined before running 
the simulation. 

 

 If we change any initial data (as the position of the 
source, air temperature,...),  we will need to run the command 
again so that this is reflected in the result. We will be able 
to choose Calculation command to obtain different pollution 
maps.  

 

 

 

 
Scale 

 
Grid size 

 
Ambient data 

 
Calculation 
parameters 

 
Sorces 

 
 

Calculation 

 
Colour gradient 

 
Numerical grid 

 
Isolines 
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Colour gradient, Isolines and Numerical grid commands should 
be applied after running the calculation. 
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7. Mathematical algorithms 

 

The mathematical model that the software uses provides options 
to model noise emissions from a wide range of sources that 
might be present at industrial areas and urban areas.  

 

The basis of the model is the linear sound propagation  
equation, which is used to model simple point source emissions 
from vehicles, industries, aircrafts,… Emission sources are 
categorized into two basic types of sources: point sources and 
line sources. The algorithms used to model each of these 
source types are described in detail in the following 
sections.  

 

The CASTOR-NOISE 5.0 software accepts meteorological data 
records to define the conditions for sound propagation. The 
model estimates the noise level for each source and receptor 
combination and calculates user-selected averages.  

 
 

For an external source, the noise level equation is 
 
 

Leq=LW-20Log(r)-11dB(A)  
 
 
where r is the distance and LW the source power. However, for 
an industrial complex, the next equation will be used: 

 
 

Leq=Li+10Log(S)-20Log(r)-14dB(A) 
 
 
where S is the external surface and Li is the internal noise 
power. 
 
 
 In a road case, we shall consider several points.  We 
shall consider a minimum number of 1000 vehicles per hour N 
with a 50km/h minimum velocity (100km/h is the maximum 
velocity). Then we have a 68 dB(A) noise level at 10m from a 
lineal road (infinity length). The noise level will be, 
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Leq=68dB(A)+30Log(v/50)+10Log(N/1000)-10Log(r/10) 
 
 
in the lineal (infinite) road case.  
 
 
In the curved road case, the program considers a finite 
element method of calculation. Each small size of road 
contributes to the total noise level. Each contribution will 
be given by  
 
 
Li=-10Log(a/180) 
 
 
being a the angle of the small road size(degrees).  
 
 
To obtain the total noise level, we add the different Li values 
following the equation 
 
 

Leq= 10.Log[i10^(Li/10)] 

 

In the railway case, we shall calculate the noise level in a 
similar way. For airports, we shall use the next equation 
 
 
Leq=Leq(300m)-20Log(r/300) 
 
 
where Leq(300m) is the noise level at 300m from the airport. 
 
 

This model performs satisfactorily for simple sound 
propagations with no ground interaction or attachment. The 
application will not consider sound reflections in the ground 
surface. 
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